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REVISION OVERVIEW
The following pages were changed relative to the previous release of this
document:
Page:
25-40
43-50
50
54

Changes:
Revised Data Points/Parameters sequences.
Revised Start-up sequence and Test Options sequence.
Added Remote Trend Buffer section.
Added “Trend Log”, “Trend Hysteresis” and “Trend Cycle” to Data Points Attributes.

ABOUT THIS USER GUIDE
This Excel 50 controller can be used in two different ways:
1.

The Excel 50 controller can be used with embedded applications.
Preconfigured applications stored in memory in the Application Module are
selected by entering a specific code via the MMI.

2.

The Excel 50 controller can also be used with standard or custom applications
created with the CARE software package and downloaded into the controller.
Custom applications may have different screens and sequences than are
shown in this document. The screens show here must be considered only as
examples.

Differences between these two uses of the Excel 50 are noted where appropriate.
NOTE

The format of the date is determined by the Engineering Units:
— US - mm/dd/yyyy
— Europe - dd.mm.yyyy
The Start-up sequence is an exception to this - the date in the Start-up
sequence must always be entered in the European format as shown
above.
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OPERATOR'S TERMINAL

The Excel 50 controller incorporates an operator's terminal with a keyboard and a
display.
Keyboard

Basic Function Keys

The keyboard has 8 basic function keys and 4 fast access keys. These 12 keys
perform the following functions:
Function
CANCEL – Escapes to the previous screen, cancels incorrect entries (provided the
'ENTER' key has not confirmed the entry) or confirms alarm messages.
ARROW UP – Moves the cursor to the previous line.
ARROW DOWN – Moves the cursor to the next line.
ARROW RIGHT – Moves the cursor to the next field of the current line.
ARROW LEFT – Moves the cursor to the previous field of the current line.
PLUS – Increases a numerical value by 1 each time the key is pressed or switches
a digital status to the opposite status condition.
MINUS – Decreases a numerical value by 1 each time the key is pressed or
switches a digital status to the opposite status condition.
ENTER – Confirms any changes made or moves to the next screen.

Fast Access Keys

Function
Plant – Displays data about the plant's current status.
Time program – Initially displays the password entry screen to provide access to
edit time program settings:
System clock (current date, time, daylight savings dates),
Daily time programs,
Weekly time programs,
Annual time programs.
Data points / parameters – Initially displays the password entry screen to provide
access to information on:
Physical, remote and pseudo user addresses, parameters, system data, DDC
program cycle time, buswide access and Flash EPROM.
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Alarms – Displays alarm information on:
Alarm history, points currently in an alarm condition, critical and noncritical
alarms.
RESET

A RESET can be achieved by pressing the following keys simultaneously:
IMPORTANT
After performing a RESET all data in the RAM and the configuration codes
are lost.

+

ARROW DOWN and MINUS – Reboots the controller and starts the 'Start-up
Sequence'
A RESET can also be achieved by pressing the hardware RESET button at the rear
of the controller housing under Terminal Block B.

Display

The display shows 4 lines of alphanumeric text with 16 characters per line.
A typical screen contains fields, either a cursor or a blinking character, 'up' and
'down' arrows and may look like the following example:

Field name. In this User
Guide it is shown in a different
font and within arrow
brackets.

<field name> >NEW
>06:00 AH1_occ ↑
>06:00 AH1_tsp 1
>06:00 AH1_tsp ↓

Cursor. Can be moved with
the arrow keys.
Places where the cursor can
be moved to. Gray arrows not
visible on real display.

Arrows indicate a list which can
be scrolled with the ARROW UP
and DOWN key.
Specifies the number of pages
the list will be scrolled when the
ARROW RIGHT and LEFT key
is pressed. Number can be
changed with '+' and '–' keys.

Selected character blinking in display.
In this User Guide it is shown
underscored. Its value can be
changed with the '+' and '–' keys.
The field name is sometimes shown in this User Guide to make a screen easier to
understand. Field names are not visible on the Excel 50 display.
NOTE

EN2B-137

The screens shown in this User Guide are examples and may differ slightly
from the screens visible on your Excel 50 controller.
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PASSWORD PROCEDURE
The following fast access keys are not password-protected:
Plant
Alarms
A password is required before the following fast access keys can be fully used:
Time programs
Data points / parameters
The password allows access to sensitive data screens.
NOTE

The password procedure will not be repeated in the following sections.
Refer back to this page for guidance on the password procedure. For more
information about the access levels see section "Operator Access Levels".

NOTE

If no password or the level-2 password is entered, only those screens are
displayed which the user may access at that operator access level.
Entering the level-3 password enables to access all data screens and to
change all values.

IMPORTANT
If you have forgotten the password, please contact your local Honeywell
branch.

Please Enter
Your Password
>****
>NEXT
Select the password field by moving the cursor with the arrow keys. Confirm with
ENTER.

Please Enter
Your Password
>3***
>NEXT
Enter the password by changing the number displayed using the '+' or '–' keys and
by moving to the next digit using the ARROW RIGHT key (Underscored character is
blinking in reality).
For operator access level 1 no password has to be entered.

Please Enter
Your Password
>***5
>NEXT
Confirm with ENTER.
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Please Enter
Your Password
>****
>NEXT
Select the 'NEXT' field using the arrow keys. Confirm with ENTER to proceed to the
next screen.

Modifying a Password
If the level-3 password has been entered, the level-2 and level-3 passwords can be
changed:

Please Enter
Your Password
>****
>CHANGE
>NEXT
Move the cursor to the 'CHANGE' field. Confirm with ENTER.

Modify Password
Level 2:>2222
Level 3:>3333
>NEXT
Select the password to be modified by moving the cursor with the arrow keys.
Confirm with ENTER.
Change the password using the '+' or '–' keys and by moving to the next digit using
the ARROW RIGHT key. Confirm with ENTER.

Modify Password
Level 2:>1775
Level 3:>3333
>NEXT
After selecting 'NEXT' the previous screen will be displayed.
NOTE

EN2B-137

The default level-2 password is '2222'.
The default level-3 password is '3333'.
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PLANT KEY

The 'Plant' procedure is used to choose the time program where changes should be
made to in the 'Time program' procedure and to make temporary changes to the
daily time program. The first screen of the 'Plant' procedure is the start screen. It is
the default screen and is always visible when no other screen has been selected.
This start screen will also be displayed if there has been no keypress for a long
time.
The screen displays the name of the first time program, the current day, the date
and the time. The next switching time of the first user address of the time program
with its current value/status is displayed below. Each time program can be assigned
to more than one user address. Each application can have up to 20 different time
programs.
Press the 'Plant' fast access key to display the default screen.

<1. time program>
MON 13.06. 10:27
to 20:30 20 °C
>TODAY
>NEXT
Select
the 'NEXT' field using the arrow keys to display the next time program.
the 'TODAY' field using the arrow keys to make temporary changes to the
actual time program.
Confirm with ENTER.
If 'NEXT' has been selected, the screen will now display the next time program with
the switching point time of the first user address with its value/status and the current
day, date and time.
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<2. time program>
MON 13.06. 10:27
to 12:00 ON
>TODAY
>NEXT
Move the cursor to the 'NEXT' field. Confirm with ENTER.

<3. time program>
MON 13.06. 10:27
to 14:30 18 °C
>TODAY
>NEXT
Like the previous screen this next screen displays the next time program with its
switching point, value/status and current day, date and time.

TODAY Function
The 'TODAY' function allows the user to make an immediate, temporary change to
the switching time point or the value/status without affecting the original time
program. When using the 'TODAY' function the data point must have value/status
and start and stop times assigned.
Important
The new start time will be within 24 hours of the current time. That means
for example, a start time of 10:00 a.m. entered at 10:27 a.m. will activate
the temporary changes the next morning. The edited fields are only valid
for 24 hours; they are automatically deleted after the stop time has been
reached.
If 'TODAY' has been selected, the screen will now display the password entry
screen.

Please Enter
Your password
>****
>NEXT
NOTE

Editing a switching time point requires level-2 or level-3 password.

Enter the level-2 or level-3 password using the arrow keys and the '+' and '–' key.
Confirm with ENTER.

<time prg.> Today
><user address>
↑
><user address>
1
><user address>
↓
Select the user address to be changed temporarily using the arrow keys. Confirm
with ENTER.

EN2B-137
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PLANT KEY

<user address>
>09:00 to>12:00
Value: >ON
>SELECT
>BACK
Edit the time or value/status using the '+' or '–' keys as required and use the arrow
keys to move from field to field. Confirm with ENTER.

<user address>
>10:00 to>13:00
Value: >ON
>SELECT
>BACK
Once editing is complete, select
SELECT to return to the selection list screen.
BACK to return to the default screen.
Confirm with ENTER.
A normal day cycle is shown below.
Day cycle:

06:00 ON
12:00 OFF
14:00 ON
20:00 OFF

Screen displays:

0000095a

Example

Systime 10:27

AH01
MON 13.06. 10:27
TO: 12:00 ON
TODAY
NEXT
6:00
Time of the next
change of state
12:00
14:00
20:00
6:00

Status

Current time

ON
OFF
ON
OFF

10:27...11:59
12:00...13:59
14:00...19:59
20:00... 5:59

12:00 14:00

20:00

t

To this day cycle a 'TODAY' entry from 10:00 to 13:00 with the status ON has been
made. The time of the next change has changed temporarily from 12:00 to 13:00.
See the following figure.
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Screen displays:

Systime 10:27

AH01
MON 13.06. 10:27
TO: 13:00 ON
TODAY
NEXT

10:00

6:00
Time of the next
change of state
13:00
14:00
20:00
6:00

0000094a

PLANT KEY

Status

Current time

ON
OFF
ON
OFF

10:27...12:59
13:00...13:59
14:00...19:59
20:00... 5:59

13:00

12:00 14:00

Active in
the next day

20:00

t

EN2B-137

14

EXCEL 50 USER GUIDE

TIME PROGRAM KEY

Select the time program by pressing the 'Plant' fast access key and changing the
screens with the NEXT field until the time program name to be changed appears in
the first line of the screen.
Press the 'Time program' fast access key to edit time program settings. The
password entry screen will be displayed.

Please Enter
Your Password
>****
>NEXT
To edit the system time requires level-2 or level-3 password. Refer to the section
'Password Procedure' for help with password entry.
Enter the password. Confirm with ENTER.
Move the cursor to the 'NEXT' field using the arrow keys. Confirm with ENTER.
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System Time
The 'System Time' procedure is used to make changes to the time and the date, the
Excel 50 controller uses for its control programs. Use the 'Daylight saving' function
instead of the 'Date / Time' function to change the time in spring and autumn.

>System Time
>Daily
>Weekly
>Annual
Move the cursor to the 'System Time' field using the arrow keys. Confirm with
ENTER.

Setting Date and Time
System Time
>Date / Time
>Daylight Saving
Move the cursor to the 'Date / Time' field using the arrow keys. Confirm with
ENTER.

System Time
Date:>13.06.1997
Time:>10:28
>BACK
Move the cursor to the 'Date' or 'Time' field using the arrow keys. Confirm with
ENTER.

System Time
Date:>23.06.1997
Time:>10:28
>BACK
If 'Date' is selected:
Set the date using the '+' or '–' keys. Use the arrow keys to move from field to field.
Confirm with ENTER. Select BACK. Confirm with ENTER to return to the previous
screen.
NOTE

EN2B-137

The date must be entered in the format determined by the Engineering
Units: for example, 23. July 1997 must be entered as 23.07.1997 for
Europe and 07/23/1997 for the US. Press the CANCEL key to abort the
operation or to cancel an incorrect entry before ENTER has been pressed.
The value previously displayed will be restored.
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TIME PROGRAM KEY

System Time
Date:>23.06.1997
Time:>12:30
>BACK
If 'Time' is selected:
Set the time using the '+' or '–' keys. Use the arrow keys to move from field to field.
Confirm with ENTER. Use the CANCEL key to return to the previous screen.
NOTE

The time must be entered in the following format: HH:MM in 24 hour clock
format; for example: 9:30 a.m. must be 09:30 and 9:30 p.m. must be
21:30. Press the CANCEL key to abort the operation or to cancel an
incorrect entry before ENTER has been pressed. The value previously
displayed will be restored.

Daylight Saving
The actual daylight saving start and end date has to be changed every year.

System Time
>Date / Time
>Daylight Saving
Move the cursor to the 'Daylight Saving' field using the arrow keys. Confirm with
ENTER.

Daylight Saving
Start:>25.03
End :>26.09
>BACK
Enter the beginning and end dates of the daylight saving time using the '+' or '–'
keys. Move from field to field using the arrow keys. Confirm with ENTER.
NOTE

Press the CANCEL key to abort the operation or to cancel an incorrect
entry before ENTER has been pressed. The value previously displayed will
be restored.

Daylight Saving
Start:>27.03
End :>26.09
>BACK
Select BACK. Confirm with ENTER to return to the start screen of the time program.
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Daily Program

>System Time
>Daily
>Weekly
>Annual
Move the cursor to the 'Daily' field in the main screen using the arrow keys. Confirm
with ENTER.
NOTE

EN2B-137

The 'Daily' program contains daily time programs.
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TIME PROGRAM KEY

AHU1
Daily
>MODIFY >NEW
>DELETE >COPY
Select
'Modify' to modify the daily time programs.
'New' to create a new daily time program.
'Delete' to delete a daily time program.
'Copy' to copy a daily time program to another.
Confirm with ENTER.

Modifying a Daily Time Program
AHU1
Modify
>Workday
>Weekend
>Shutdown

↑

1
↓

Move the cursor to the daily time program to be modified and press ENTER.
Creating a New Switching Point

AHU1
>NEW
>06:00 <user addr.>↑
>06:00 <user addr.>1=
>06:30 <user addr.>↓
To create a new switching point select 'New'. Confirm with ENTER.

AHU1
Workday
><user addr.>
↑
><user addr.>
1
><user addr.>
↓
Select the user address the new switching point should belong to.

AHU1
sp01
>06:01 >20.0 °C
Opt: >OFF
>OK
Modify the time, the value or the optimize flag of the new switching point using the
'+' or '–' keys (The optimize flag can only be set to ON if the user address is suitable
for optimization).
Use the arrow keys to move from field to field. Confirm with ENTER.
Select OK and confirm with ENTER to add the new switching point to the actual
time program.
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Modifying or Deleting a Switching Point

AHU1
>NEW
>06:00 <user addr.>↑
>06:00 <user addr.>1=
>06:00 <user addr.>↓
To modify or delete a switching point select the switching point. Confirm with
ENTER.

AHU1
<user addr.>
>06:00 >20.0°C
Opt: >OFF
>DELETE
Modify the time, the value or the optimize flag of the switching point. Move the
cursor to the field to be edited using the arrow keys. Confirm with ENTER.
Use the '+' and '–' keys to change the field content. Select the 'Delete' field to delete
the switching point.

AHU1
<user addr.>
Really delete
switchp 06:00?
>YES
>NO
Select 'YES' to delete the switching point or select 'NO' to escape to the previous
screen without deleting the switching point. Confirm with ENTER.

Creating a New Daily Time Program
Select 'YES' to create a new daily time program. Confirm with ENTER.

AHU1
new daily prog.
DP 1
>MODIFY >BACK
The newly created daily time program gets the name DP and the lowest number
which is not assigned to a daily time program.
Select
'MODIFY' to go to the 'Modify daily time program' sequence.
'BACK' to go back to the 'Time program' menu screen.
Confirm with ENTER.

EN2B-137
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TIME PROGRAM KEY

Deleting a Daily Time Program
AHU1
Delete
>Workday
↑
>Weekend
1
>Shutdown
↓
Select the daily time program to be deleted using the arrow keys. Confirm with
ENTER.

AHU1
Really delete
Shutdown ?
>YES
>NO
Select 'YES' to delete the daily time program or 'NO' to keep it. Confirm with
ENTER.

Copying a Daily Time Program
A daily time program can be copied in order to create a new daily time program
which should be similar to an already existing daily time program.

AHU1
Copy
>Workday
>Weekend
>Shutdown

↑

1
↓

Choose the daily time program to be copied using the arrow keys. Confirm with
ENTER.

AHU1
Weekend
copied to
DP_2
>BACK
The copy of the daily time program gets the name DP and the lowest number which
is not assigned to a daily time program.

Weekly Program
>System Time
>Daily
>Weekly
>Annual
Select the 'Weekly' field using the arrow keys. Confirm with ENTER.
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AHU1
Weekly
>MON Workday
↑
>TUE Workday
1
>WED Workday
↓
A daily time program is assigned to each day of the week in the weekly time
program. To assign another daily time program to a day of the week select this day.
Confirm with ENTER.

AHU1
>Workday
>Weekend
>DP 1

MON
↑

1
↓

Select the daily time program to be assigned to the day of the week displayed in the
upper right corner. Confirm with ENTER.

AHU1
MON
really assign
Weekend
?
>YES
>NO
Select 'YES' to assign the daily time program to the weekday or 'NO' to escape from
this screen without any changes. Confirm with ENTER.

Annual Program
System Time
>Daily
>Weekly
>Annual
Move the cursor to the 'Annual' field using the arrow keys. Confirm with ENTER.

AHU1
Annual
display from
>23.06.1997
>NEXT
The annual program will be displayed from the date shown in this screen. The
default date is the current date. Move the cursor to the date field. Confirm with
ENTER.
Use the '+' or '–' keys to change the date and move to the next digit using the
ARROW RIGHT key. Confirm with ENTER.
Move the cursor to the 'NEXT' field using the arrow keys. Confirm with ENTER.

AHU1
Workday
From: 22.12.1997
To:
07.01.1998
>CHANGE
>NEXT

EN2B-137
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TIME PROGRAM KEY
In this screen the name of the daily time program which is assigned to the period is
shown.
If there is no daily time program assigned to the annual schedule, the following
screen appears:

AHU1
********
FRI 16.05.1997
FRI 16.05.1997
>CHANGE
>NEXT
For both screens select
'NEXT' to display the next period a daily time program is assigned to.
'CHANGE' and confirm with ENTER to change the settings for the shown
period.
Confirm with ENTER.

AHU1
Workday
From:>22.12.1997
To: >07.01.1998
>REMOVE >ASSIGN
If 'Change' has been selected this screen will be displayed. Move the cursor to the
date fields using the arrow keys to change the dates. Confirm with ENTER. Use the
'+' and '–' keys to change the start and end dates.
Select
ASSIGN to assign another daily time program to the period.
REMOVE to remove the daily time program shown in the first line of the screen
from the period.
Confirm with ENTER.

AHU1
SELECT:
>Workday
↑
>Weekend
1
>DP 4
↓
If 'ASSIGN' has been selected, this screen will show up. Select a daily time program
to assign it to the previously entered period of time. Confirm with ENTER.

AHU1
really remove
entry?
>YES
>NO
If 'REMOVE' has been selected this screen will show up. Select 'YES' to remove the
daily time program from the period. Confirm with ENTER.
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DATA POINTS / PARAMETERS KEY

0000128b

Fast access key: Data Points / Parameters

Please Enter
Your Password
3***
NEXT

Separate overviews
for data point screens.

**
*

Analog Input
Analog Output
Digital Input
NEXT

**

Digital Output
Totalizer
Hours Run
BACK
NEXT

**
*
**

M-Bus Data
Pseudo Analog
Pseudo Digital
BACK
NEXT

Remote Analog
Remote Digital
Manual Operat.
BACK
NEXT

<user addr.>
<user addr.>
<user addr.>
<user addr.>

↑

1
↓

<user addr.>
<value> Hours
Switch <status>
<value>
↑

Point in Trend
Parameters
System Data
BACK
NEXT

<user addr.>
<user addr.>
<user addr.>
<user addr.>

M-Bus Config
DDC-Times
Buswide Access
BACK
NEXT

<user addr.>
<user defined text>
<value>
MANUAL
BACK

1
↓

Trend Buffer
Flash EPROM
BACK
Separate overview
for these screens.
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Data Points sequence
analog points

*

0000125a

DATA POINTS / PARAMETERS KEY

↑

<user addr.>
<user addr.>
<user addr.>
<user addr.>

1
↓

<user addr.>
<user defined text>
<value>
AUTO
NEXT
<user addr.>
Suppress Alarm
YES
BACK
NEXT
(only AO)

Time to
Open
Close
BACK

0.0sec
0.0sec
NEXT

Min Lim2 <value>
Min Lim1 <value>
BACK

NEXT
(only PA)

Max Lim1 <value>
Max Lim2 <value>
S.Offset <value>
BACK
NEXT
<user addr.>
Tech Addr:<value>
Trend log: YES
BACK
NEXT
Trend Hysteresis
1.0 Pct
Trend Cycle:
0000 min
BACK

EN2B-137
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Max Lim1 <value>
Max Lim2 <value>
Trend log: YES
BACK
NEXT

DATA POINTS / PARAMETERS KEY
Data Points sequence
remote points

*
↑

0000126a

<user addr.>
<user addr.>
<user addr.>
<user addr.>
Data Points sequence
digital and totalizer points

1
↓

<user addr.>
<user defined text>
<value>
AUTO
NEXT

*
<user addr.>
<user addr.>
<user addr.>
<user addr.>

0000127b
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↑

1
↓

<user addr.>
<user defined text>
<value>
AUTO
NEXT

<user addr.>
Suppress Alarm
YES
BACK
NEXT

(CARE applications only)

<user addr.>
RemoteController
Number:
0
BACK
NEXT

<user addr.>
Tech Addr:<value>
Trend log: YES
BACK
NEXT
(analog only)

<user addr.>
Suppress Alarm
YES
BACK
NEXT
<user addr.>
Tech Addr:<value>
Trend log: YES
BACK
NEXT

Trend Log:
BACK

(only PD
and PT)

<user addr.>
Trend log:

YES
NEXT

<user addr.>
Broadcast Hyst.:
<value>
BACK
NEXT

(analog only)

Trend hyster:
1.0 Pct
Trend Cycle:
0000 min
BACK

YES
BACK

Press the 'Data points / parameters' fast access key to get access to information on
physical, remote and pseudo user addresses, parameters, system data and the
DDC program cycle time.
The password entry screen will be displayed.

Please Enter
Your Password
>****
>NEXT
To get access to information on user addresses, parameters, system data and the
DDC program cycle time requires the level-2 or level-3 password. Refer to the
section 'Password Procedure' for help with password entry.
Enter the password. Confirm with ENTER.
Move the cursor to the 'NEXT' field using the arrow keys. Confirm with ENTER.
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Data Points
>Analog Input
>Analog Output
>Digital Input
>NEXT
Select
'Analog Input', 'Analog Output' or 'Digital Input' to go into the 'Data points'
sequence.
'NEXT' to proceed to the next screen.
Confirm with ENTER.

>Digital Output
>Totalizer
>Hours Run
>BACK
>NEXT
Select
'Digital Output' or 'Totalizer' to go into the 'Data points' sequence.
'Hours run' to go to the 'Hours run' screen.
'NEXT' to proceed to the next screen.
'BACK' to go to previous screen.
Confirm with ENTER.

>M-Bus Data
>Pseudo Analog
>Pseudo Digital
>BACK
>NEXT
Select
'M-Bus Data', 'Pseudo Analog' or 'Pseudo Digital' to go into the 'Data Points'
sequence. M-Bus Data will only show special pseudo points related to the MBus. These special points also appear under the Pseudo Analog and Pseudo
Digital.
'NEXT' to proceed to the next screen.
'BACK' to go to previous screen.
Confirm with ENTER.

>Remote Analog
>Remote Digital
>Manual Operat.
>BACK
>NEXT
Select
'Remote Analog' or 'Remote Digital' to go into the 'Remote points' sequence.
'Manual Operat.' to go to the 'Manual operation' screen.
'NEXT' to proceed to the next screen.
Confirm with ENTER. The sequence proceeds to the Parameters sequence
discussed separately in a later section.

Data Points Sequence
The Data Points sequence will change depending upon the type of data point
selected. Only the complete sequence for analog input points will be shown here as
an example. Features unique to other data point types will be shown afterwards.
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Selecting one of the data point types will display the first screen of the 'Data Points'
sequence.

><user addr.>
><user addr.>
><user addr.>
><user addr.>

↑

1
↓

Move the cursor to select the data point from the list box using the arrow keys.
Confirm with ENTER.

<user addr.>
<user defined text>
><value>
>AUTO
>NEXT
In this screen the operating mode field can be changed from 'AUTO' to 'MANUAL'
and vice versa and the setpoint value/status can be edited. Move the cursor to the
appropriate field using the arrow keys. Confirm with ENTER.
Change the value/status using the '+' or '–' keys. Confirm with ENTER.
If the operating mode is changed, an alarm screen with the message "Manual
operation" or "Auto operation" appears. Confirm the alarm with CANCEL.
Move the cursor to the 'NEXT' field using the arrow keys. Confirm with ENTER.

<user addr.>
Suppress Alarm
>YES
>BACK
>NEXT
The alarm suppression attribute of the user address can be changed from 'YES' to
'NO' and vice versa. Move the cursor to the appropriate field using the arrow keys.
Confirm with ENTER.
Change the status using the '+' or '–' keys. Confirm with ENTER.
Move the cursor to the 'NEXT' field using the arrow keys. Confirm with ENTER.

Min lim2><value>
Min lim1><value>
>BACK

>NEXT

This and the next screen will only be shown for analog input and pseudo analog
data points. Change the value of the alarm minimum limit attributes by using the '+'
and '–' keys. Confirm with ENTER.
Move the cursor to the 'NEXT' field using the arrow keys. Confirm with ENTER.

Max lim1><value>
Max lim2><value>
S.Offset><value>
>BACK
>NEXT
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Change the value of the alarm maximum limit attributes and the sensor offset by
using the '+' and '–' keys. Confirm with ENTER.
Move the cursor to the 'NEXT' field using the arrow keys. Confirm with ENTER.

<user addr.>
Tech Addr <value>
Trend log: YES
>BACK
>NEXT
This screen displays the technical address of the data point. The technical address
is a number with 6 digits in pairs of two and stands for the following data:

XX XX XX
Physical point address
Board number
Controller number
For an explanation of Board Number, see the Test Options section. To enable trend
logging for this data point, move the cursor to the appropriate field using the arrow
keys. Confirm with ENTER.
Change the value/status using the '+' or '–' keys. Confirm with ENTER. Move the
cursor to the 'NEXT' field using the arrow keys. Confirm with ENTER. The following
screen appears for Remote Analog points only:

Trend hysteresis
1.0 Pct
Trend Cycle:
0000 min >BACK
To change the Trend Hysteresis or Trend Cycle attibutes, move the cursor to the
appropriate field using the arrow keys. Confirm with ENTER.
Change the value/status using the '+' or '–' keys.
NOTE

Remote Points

If Trend Cycle is set to anything besides 0000, time-based trending is
enabled. If Trend Cycle is set to 0000, then value hysteresis trending is
enabled using the percent value show for Trend Hysteresis.

This screen is only visible for remote points and shows the controller number of a
remote point.

<user addr.>
RemoteController
Number:
0
>BACK
>NEXT
Edit the controller number using the '+' and '–' keys. Confirm with ENTER. For
points which the controller receives from other controllers on the C-Bus, the
controller number of the source of the point must be entered. For points that the
controller is the source of, the default value of 0 is required.
Move the cursor to the 'NEXT' field. Confirm with ENTER.
Analog Outputs
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actuator needs to open and close a valve.
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Time to
Open
Close
>BACK

0.0sec
0.0sec
>NEXT

Edit the values using the '+' and '–' keys. Confirm with ENTER.
Move the cursor to the 'NEXT' field using the arrow keys. Confirm with ENTER.
CARE Applications

For applications created in CARE, the sequence for Remote Digital points ends with
the second screen, showing user address, state, and mode. The sequence for
Remote Analog points proceeds to the following one:

<user addr.>
Broadcast Hyst.:
<value>
>BACK
>NEXT
This screen allows editing the Broadcast Hysteresis attibute. The attribute is
available for remote analog datapoints in CARE applications (not applicable to
configurable applications). Broadcast Hysteresis prevents new values from being
broadcast to other controllers unless the datapoint value changes (positively or
negatively) at least by the amount specified in this screen. Move the cursor to the
appropriate field using the arrow keys. Confirm with ENTER.
Change the value/status using the '+' or '–' keys. Confirm with ENTER.

Hours Run
Digital Output
Totalizer
>Hours Run
BACK
NEXT
Move the cursor to select the 'Hours Run' field by using the arrow keys. Confirm
with ENTER.

><user addr.>
<user addr.>
<user addr.>
<user addr.>

↑

1
↓

Move the cursor using the arrow keys to select the appropriate user address from
the list box. Confirm with ENTER.

<user addr.>
><value>
hours
Switch <status>
><value>
The screen displays the total running hours logged together with the number of
times the device has been switched on. If you have accessed the 'Data points /
parameters' procedure with the level-3 password, the values can be changed using
the '+' and '–' keys.
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Manual Operation
>Remote Analog
>Remote Digital
>Manual Operat.
>BACK
>NEXT
Move the cursor to select the 'Manual Operat.' field by using the arrow keys.
Confirm with ENTER.

><user addr.>
><user addr.>
><user addr.>
><user addr.>

↑

1
↓

Move the cursor to select the user address from the list box using the arrow keys.
Confirm with ENTER.

<user addr.>
<user defined text>
><value>
>MANUAL
>BACK
In this screen the operating mode field can be changed from 'MANUAL' to 'AUTO'
and vice versa and the setpoint value/status can be edited. Move the cursor to the
appropriate field using the arrow keys. Confirm with ENTER.
Change the value/status using the '+' or '–' keys. Confirm with ENTER.
If the operating mode is changed, an alarm screen with the message "Manual
operation" or "Auto operation" appears. Confirm the alarm with CANCEL.
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Parameters

List:
000
Number:
001
Val:
20.00
BACK

0000122c

Point in Trend
Parameters
System Data
BACK
NEXT
M-Bus Config
DDC-Times
Buswide Access
BACK
NEXT

HM1 - 1
HM2 - 1
WM1 - 1

Softw.:V2.00.00
BaudrBus: 76800
Contr.No: 1
BACK
NEXT

↑

<user addr.>
<user addr.>
<user addr.>
<user addr.>

DDC-Times
Exec. Time:1.72
Cycl. Time:3.00
BACK

<user addr.>
<value>
Trend log

1
↓

ON
BACK

1

Trend Buffer
Flash EPROM

Applicat.
<version>
BACK

NEXT

Controller Name:
<controller name>
Reset Modem
BACK
NEXT

BACK
<user addr.>
<user addr.>
<user addr.>
<user addr.>

Flash EPROM
SAVE APPLIC.
ERASE FLASH
BACK

↑

1
↓

Buswide Access
LOGIN LOGOFF
Remote Alarms
ON
OFF
3

BdrRS232:<bdrate>
BdrModem:<bdrate>
BdrM-Bus:<bdrate>
BACK
NEXT

<user addr.><unit>↑
<time> <value> 1
<time> <value>
<time> <value> ↓

Burning Flash
Please wait!

↑

1
↓=

4

2

GSM PIN:********
BACK

Remote Login
<controller>
<controller>
<controller>

<1. time program>
MON 13.06. 10:27
to 20:30 20 °C
TODAY
NEXT

Erasing Flash
Please wait!

NEXT

Appl. Mem. Size
128 Kbytes
Rem. Trend Buf.
104 Entries NEXT
1

Config.
NEXT
C1<code>C2<code>
C3<code>C4<code>
C5<code>C6<code>

1

These screens appear only with configurable
application controllers.

2

These screens appear only when modem
communication is enabled.

3

This screen belongs to the local controller
again after logging off from the remote controller.

4

This screen belongs to the chosen remote
controller.

5

This screen only appears for certain applications
requiring 8 application codes.

5

CONFIG.

BACK

C7<code>C8<code>
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>Point in Trend
>Parameters
>System Data
>BACK
>NEXT
Select 'NEXT' to display the second screen of the 'Parameters' menu. Confirm with
ENTER.

>M-Bus Config
>DDC-Times
>Buswide Access
>BACK
>NEXT
Select 'NEXT' to display the third screen of the 'Parameters' menu. Confirm with
ENTER.

>Trend Buffer
>Flash EPROM >
>BACK
Point in Trend
>Point in Trend
>Parameters
>System Data
>BACK
>NEXT
Move the cursor to the 'Point in Trend' field using the arrow keys. Confirm with
ENTER.

><user addr.>
><user addr.>
><user addr.>
><user addr.>

↑

1
↓

Move the cursor to select the data point from the list box using the arrow keys.
Confirm with ENTER.

<user addr.>
<value>
Trend Log

ON
>BACK

To enable trend logging for this data point, move the cursor to the appropriate field
using the arrow keys. Confirm with ENTER.
Change the value/status using the '+' or '–' keys. Confirm with ENTER. Move the
cursor to the 'BACK' field using the arrow keys. Confirm with ENTER to return to the
list of Points in Trend.
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Parameter List
>Point in Trend
>Parameters
>System Data
>BACK
>NEXT
Select the 'Parameter's field from the first screen of the Parameters sequence using
the arrow keys to view or edit control parameters of devices connected to the
controller. Confirm with ENTER. Editing parameters requires the level-3 password.

List
000
NO.
001
Val.>20.00
°C
>BACK
Select the 'value' field using the arrow keys to edit the parameter value. Confirm
with ENTER.
Use the '+' or '–' keys to change the value. Confirm with ENTER.
Move the cursor to the 'BACK' field. Confirm with ENTER to return to the parameter
list screen.

System Data
>Point in Trend
>Parameters
>System Data
>BACK
>NEXT
Move the cursor to the 'System Data' field using the arrow keys. Confirm with
ENTER.

Softw.:V 2.00.00
BaudrBus:>76800
Contr.NO:>1
>BACK
>NEXT
Move the cursor to the data field to be edited by using the arrow keys. Confirm with
ENTER.
Change the values using the '+' or '–' keys. Confirm with ENTER.
Move the cursor to the 'NEXT' field using the arrow keys. Confirm with ENTER to
proceed to the next screen (which depends upon the type of Application Module
used).

Application<name>
<version>
>BACK

This screen appears in
configurable applications only.

>NEXT

This screen displays the name of the current application and its version. 'NEXT' is
preselected to move to the controller name screen. Confirm with ENTER.
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Controller Name:
<controller name>
Reset Modem
>BACK
>NEXT
Move the cursor to the Controller Name field to edit it by using the arrow keys.
Confirm with ENTER.
Select 'Reset Modem' to reset modem to factory setting (insure that the modem is
connected). Confirm with ENTER.
IMPORTANT
Resetting the modem will restore the factory defaults and erase any
custom initialization.
'NEXT' is preselected to move to the baudrate screen. Confirm with ENTER.

BdrRS232:<bdrate>
BdrModem:<bdrate>
BdrM-Bus:<bdrate>
>BACK
>NEXT
Move the cursor to the baudrate field to be edited by using the arrow keys. Confirm
with ENTER.
NOTE

Password Level 2 is required to change the baudrates:

Change the values using the '+' or '–' keys. Confirm with ENTER.. Select ‘NEXT’
and confirm with ENTER. The following appears:

GSM PIN:********

This screen appears only when
modem communication is enabled.

>NEXT

BACK

Use the arrow keys to select the ‘GSM PIN’ field to enter the password for GSM
communication. Press ENTER to enter the field. Press the '+' or '–' keys to
increment/decrement the digit. Press ENTER to confirm the digit. Press left or right
arrow key to move to the next digit. When all digits are entered press ENTER twice
to confirm the PIN.
IMPORTANT
The GSM PIN must be entered right justified.
The modem baudrate must be set to 9600 for GSM communication to
work.
Select ‘NEXT’ and confirm with ENTER.

Appl. Mem. Size
128 Kbytes
Rem. Trend Buf.
104 Entries>NEXT

This screen appears only when
modem communication is enabled.

This screen displays the size of the adjustable remote trend buffer. The number of
entries (trend samples) that can be stored in the buffer for Remote Building Central
A is determined by a calculation by the controller based upon the Application
Memory Size entered in the Start-up sequence. The values shown can only be
changed by resetting the controller and entering a new value for Appl. Mem. Size in
the Start-up sequence.
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NOTE

Firmware V2.03.01 or later and CARE V2.02.00 or later enable the
controller to run RACL partly from the Flash EPROM. Thus, the application
memory calculation is different compared to older versions. This has to be
considered during start up once you enter the application memory size.
1. CARE V2.02.00 or later:
The maximum application size is 128 Kbytes (128 Kbytes flash
memory). Enter the application size calculated by CARE.
2. CARE versions before V2.02.00 without modem:
The maximum application size calculated by the old CARE is
113 Kbytes because the complete application including RACL runs
from the RAM. The controller will not run if the application is bigger.
You need to use CARE at least V2.02.00 if your applications require
more than 113 Kbytes.
Applications bigger than 113 Kbytes without modem will not run
from the flash memory after firmware download of OS V2.03.01 if
they were done with CARE versions before V2.02.00.
3. CARE versions before V2.02.00 with modem:
The maximum application size calculated by the old CARE is
100 Kbytes. The controller will not run if the application is bigger. For
the calculation of the trend buffer you need to enter 28 Kbytes plus the
application size calculated by the old CARE version, e.g., CARE
before V2.02.00 calculated 98 Kbytes, thus you will enter 126 Kbytes
(98 Kbytes + 28 Kbytes) on the MMI of the controller.
We strongly recommend to use CARE V2.02.00 or later if you use
modem communication. This will allow for applications with up to
128 Kbytes (128 Kbytes flash memory).
Applications bigger than 100 Kbytes with modem will not run
from the flash memory after firmware download of OS V2.03.01 if
they were done with CARE versions before V2.02.00.
4. Configurable applications:
Always enter 128 Kbyte for the application memory size.

'NEXT' is preselected to move to the following screen. Confirm with ENTER. For
configurable application controllers, the configuration codes screen is displayed as
the final one in the sequence.

Config.
C1<code>
C3<code>
C5<code>

>NEXT
C2<code>
C4<code>
C6<code>

This screen appears in
configurable applications only.

In this screen the codes of the configurable application can be viewed.
NOTE

Not all applications have 6 configuration code numbers. Applications with
8 configuration codes have two on a second screen as shown below.
Second screen:

CONFIG.

>BACK

C7<code>

C8<code>

This screen appears in
configurable applications only.

IMPORTANT
After performing a RESET all data in RAM and the configuration codes are
lost.
To change the codes perform a RESET (press ARROW DOWN and MINUS
simultaneously). The codes can then be changed In the 'Start-up' sequence.
Select BACK. Confirm with ENTER.
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M-Bus Configuration
>M-Bus Config
>DDC-Times
>Buswide Access
>BACK
>NEXT
Move the cursor to the 'M-Bus Config' field using the arrow keys. Confirm with
ENTER.

HM1 - 1
HM2 - 1
WM1 - 1

=

This screen displays the bus numbers for up to 3 heat meters and/or up to 2 water
meters on the Meter Bus (up to max. 3 meters in total). A value of 0 or lower (-1
default) means no device is connected. Move the cursor using the arrow keys to the
'bus number' field. Confirm with ENTER.
Use the '+' or '–' keys to edit the value. Confirm with ENTER.
Select CANCEL to return to the previous screen.

DDC Program Cycle Times
>M-Bus Config
>DDC-Times
>Buswide Access
>BACK
>NEXT
Move the cursor to the 'DDC-Times' field using the arrow keys. Confirm with ENTER.

DDC-Times
Exec.Time: 1.72
Cycl.Time:>3.00
>BACK
This screen displays the RACL cycle time and execution time in seconds. The cycle
time can be edited to optimize the system performance. Editing the cycle time
requires the level-3 password. Move the cursor using the arrow keys to the 'Cycle
time' field. Confirm with ENTER.
Use the '+' or '–' keys to edit the value. Confirm with ENTER.
Select BACK. Confirm with ENTER.

Buswide Access
>M-Bus Config
>DDC-Times
>Buswide Access
>BACK
>NEXT
The 'Buswide Access' function uses the MMI of this controller to view or to make
changes to other EXCEL 50 controllers without MMI which are connected to the
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same bus. Move the cursor to the 'Buswide Access' field using the arrow keys.
Confirm with ENTER.

Buswide Access
LOGIN LOGOFF
Remote Alarms
ON
OFF
Select
'LOGIN' to log in to another controller on the same bus.
'LOGOFF' to log off from the remote controller where you are logged in at the
moment.
'ON' to enable the logging of alarms coming from other controllers on the bus
(these alarms can then be displayed after pressing the Alarms fast access key
in the 'Buswide Alarms' menu).
'OFF' to disable the logging of alarms coming from other controllers on the bus.
Confirm with ENTER.
If 'LOGIN' has been selected, this screen will show up:

Remote Login
<controller>
<controller>
<controller>

↑

1
↓

Select the controller you want to log in. Confirm with ENTER.
IMPORTANT:
From now on all visible screens are the screens of the remote controller.
The first screen of the remote controller will be the start screen. You can
now access all screens of the remote controller. Use the 'Buswide Access'
function via the 'Data Points / Parameters' fast access key to return to the
screens of your own controller. Use the LOGOFF function or select your
own controller in the controller list of the LOGIN function. If you do not
press a key for 10 min, you will also be logged off. You will return to the
controller list screen of the LOGIN function on your own controller.
Logging in to a controller that uses an XI581/582 MMI results in only part
of the information from that controller being displayed on the Excel 50
screen due to the smaller screen size on the Excel 50 MMI.
If 'LOGOFF' has been selected, you will be logged off from the remote controller
and return to the controller list screen of the LOGIN function on your own controller.
If 'ON' or 'OFF' has been selected, alarms from remote controllers will be displayed
or suppressed. The screen will remain the same and no changes are visible.

Trend Buffer
>Trend Buffer
>Flash EPROM
>BACK
Move the cursor to the 'Trend Buffer' field using the arrow keys. Confirm with
ENTER.
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><user addr.>
><user addr.>
><user addr.>
><user addr.>

↑

1
↓

Move the cursor to select the data point from the list box using the arrow keys.
Confirm with ENTER.

<user addr.> <unit> ↑
< time>
<value> 1
< time>
<value>
< time>
<value> ↓
In this screen the trend buffer entries for the data point can be viewed using the
normal methods for moving through a list box.
Return to the list of data point in trend with CANCEL.

Flash EPROM
>Trend Buffer
>Flash EPROM
>BACK
Move the cursor to the 'Flash EPROM' field using the arrow keys. Confirm with
ENTER.

Flash EPROM
>SAVE APPLIC.
>ERASE FLASH
>BACK
Select
'SAVE APPLIC.' to burn all data of the current application data into the Flash
EPROM.
'ERASE FLASH' to erase all data from the Flash EPROM.
Confirm with ENTER.
If 'SAVE APPLIC.' has been selected, this screen will show up:

Burning Flash
please wait!
If 'ERASE FLASH' has been selected, this screen will show up:

Erasing Flash
please wait!
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Press the 'Alarms' fast access key to display alarm information on alarm history,
points currently in an alarm condition, critical alarms, noncritical alarms and
buswide alarms.

>Alarm Buffer
>Point in Alarm
>Critical Alarm
>NEXT
Confirm with ENTER to go to the second screen of the 'Alarms' procedure.

>NoneCrit.Alarm
>Buswide Alarms
>BACK
Move the cursor using the arrow keys to select the desired item from the first or
second page of the alarm menu, e.g. 'Point in alarm'. Confirm with ENTER.

><alarm name>
><alarm name>
><alarm name>
><alarm name>

↑

1
↓

The screen displays all the points currently in alarm in the list box. To access more
information about a specific alarm, move the cursor using the arrow keys to select
the appropriate alarm name. Confirm with ENTER.
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<date>
<time>
<alarm name>
<value/status>
<predefined text>
Alarm information comprising the date, time, alarm name, value/status and
alarm reason is displayed. Press CANCEL to return to the previous screen.
NOTE

The same operating method as described for 'Point in alarm' applies
to the 'Alarm buffer', 'Critical alarm' and 'Noncritical alarm'.

If the item 'Buswide alarms' has been chosen from the alarm menu, the following
screen will show up:

Buswide Alarms
><contr.name> 01 X↑
><contr.name> 02 X1
><contr.name> 03 X=↓
This screen shows a list of all controllers connected to the bus. Move the cursor the
appropriate controller. Confirm with ENTER.

><Alarm name>
><Alarm name>
><Alarm name>
><Alarm name>

↑

1
↓

A list box with all alarms in the alarm buffer of the specified controller will be shown.
Select the appropriate alarm. Confirm with ENTER.
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START-UP SEQUENCE
0000121c

After powering up or RESET

Honeywell
XL 50
V.2.03.00
NEXT
Enable
Modem Part
YES

Select Applic.
Requ. Download
Gen. Def. Data
NEXT

Please execute
Download

DISP DEF DATA
Alarm History

CARE Applications
(example only)

NO

Choose Applic.
↑
AH01
<applic. name>
1
↓
<applic. name>

Embedded Applications

1

Honeywell
XL 50
V.2.03.00
NEXT

<User Addr.>
<User Addr.>
<User Addr.>
<User Addr.>

↑

1
↓

Honeywell
XL 50
V 2.01.01
NEXT

Honeywell
XL 50 V 2.03.00
AH01 V 1.00
NEXT
2

<time>

NO

<date>
<User Addr.>
<value>
<Alarm text>

Append Busnumber
to User Addr. ?
YES
NEXT

Append Busnumber
to User Addr. ?
YES
NEXT

Appl. Mem.Size
128 KB RESTART
Re. Trend Buf.:
104 Entr. NEXT

<User Addr.>
<User Addr.>
<User Addr.>
<User Addr.>

<val.>↑
<val.>1
<val.>
<val.>↓

<1. time program>
MON 13.06. 10:27
TO: 20:30 20°C
TODAY
NEXT

C1<code> C2<code>
C3<code> C4<code>
C5<code> C6<code>
NEXT

<date>
<User Addr.>
<value>
<Alarm text>

<time>

Enable
Modem Part
YES
1

3
4

Bdr. Mod: 9600
GSM PIN ********
Reset Modem
NEXT

Date: 13.06.1997
Time: 17.35
NEXT
Bdr. Bus: 76800
Ctr. No: 1
Bdr. M-Bus: 2400
NEXT

CONFIG
C7<code> C8<code>

Yes
1

THE SAME ENTRY (YES OR NO) MUST BE MADE BOTH
TIMES THE ENABLE MODEM SCREEN APPEARS OR THE
SEQUENCE STARTS AGAIN FROM THE BEGINNING.

2

THIS SCREEN IS SKIPPED IN THE HE01 APPLICATION.
THE BUS NUMBER IS APPENDED AUTOMATICALLY.

3

IF A NEW VALUE IS ENTERED FOR APPLICATION MEMORY
SIZE, THE SEQUENCE STARTS AGAIN FROM THE BEGINNING.
(See page 36/37.)

4

THIS SCREEN ONLY APPEARS FOR CERTAIN
APPLICATIONS REQUIRING 8 CONFIGURATION CODES.

No

Configuration
successful?

<1. time program>
MON 13.06. 10:27
TO: 20:30 20°C
TODAY
NEXT

After powering up the controller or after a RESET the initial screen of the 'Start Up'
sequence appears. A RESET can be achieved by pressing the 'DOWN' and '–' keys
simultaneously.
NOTE

The screens of the Start Up sequence are always displayed in English as
they are a part of the operating system.
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Honeywell
XL 50
V 2.03.00

>NEXT

This is the first screen of the Start-up sequence. It shows the version of the
company name, the controller name and the firmware version. Confirm with
ENTER.

Enable
Modem Part
>NO

YES

This screen allows the user to enable modem communication. Select YES and
confirm with ENTER.

Honeywell
XL 50
V 2.03.00
>NEXT
The controller is reset, and the first screen of the Start-up sequence is shown.
Confirm with ENTER.

Enable
Modem Part
>NO

YES

The Enable Modem screen is repeated. The same YES/NO response selected
previously must be selected again. If YES was selected the first time and NO is
selected now (or visa-versa), the sequence will start over from the beginning. Select
YES and confirm with ENTER.
If modem communication has been enabled, the following two screens appear,
otherwise the sequence proceeds directly to the Date and Time screen.

Appl. Mem. Size
128 KB RESTART
Re. Trend Buf.:
104 Entr. >NEXT
This screen is used to increase the size of the adjustable remote trend buffer ba
reducing the application memory size. The number of entries (trend samples) that
can be stored in the buffer for Remote Building Central A is determined by a
calculation by the controller based upon the Application Memory Size entered in this
screen (remote trend buffer = (128 Kbytes-appl. Size) * 1024 bytes / 47 bytes). The
default for Appl. Mem. Size is 128. The default number of Remote Trend Buffer
Entries is 104.
Also see page 50 ‘Adjustable Remote Trend Buffer (V2.03.x)’.
If a new value for Appl. Mem. Size has not been entered, the cursor is at NEXT.
Confirm with ENTER and continue to the next screen.
To increase the size of the buffer, use the arrow keys to select the digits for ‘Appl.
Mem. Size’ and use the ‘+’ and '–' keys to enter a new value. Then select RESTART
and confirm with ENTER. The controller will reset again, and the ‘Start-up’
sequence starts again from the beginning.
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START-UP SEQUENCE
IMPORTANT
If the application being downloaded exceeds the Maximum Application
Size entered in this screen, an error message will occur and the download
will not be executed (see NOTE on pages 36/37).
When this screen appears again, the cursor is at NEXT. The new application
memory size and the new number of trend samples calculated by the controller are
shown. Confirm with ENTER and continue to the next screen.

Bdr. Mod. 9600
GSM PIN ********
Reset Modem
>NEXT
This screen only appears if modem communication is enabled. Select:
— ‘Bdr. Mod.’ to set the baud rate for the modem/ISDN terminal adapter.
— ‘GSM PIN’ to set the GSM Personal Identification Number (PIN).
— 'Reset Modem' to return modem to factory settings, erasing any custom
modem initialization. See Remote Communications section for more
information.
Move the cursor with the arrow keys to the appropriate fields. Use the '+' and '–'
keys to edit the fields.
NOTE
NOTE

The GSM PIN must be entered right-justified.
For GSM communication, the modem baud rate must be set at 9600.

Or select Reset Modem to send a reset command to the modem (if one is not yet
attached to the controller, the controller will send a reset when one is detected).
IMPORTANT
Resetting the modem will restore the factory defaults and erase any
custom initialization.
Confirm with ENTER.

Date:>13.06.1998
Time:>17:35
>NEXT
Select:
— the 'Date' field to enter the actual date.
— the 'Time' field to enter the actual time.
Confirm with ENTER.
If 'Date' is selected:
Set the date using the '+' or '–' keys. Use the arrow keys to move from field to field.
Confirm with ENTER. Select BACK. Confirm with ENTER to return to the previous
screen.
NOTE

The date must be entered in the following format: DD. MM. YYYY; for
example, 23. July 1997 must be entered as 23. 07. 1997. Press the
CANCEL key to abort the operation or to cancel an incorrect entry before
ENTER has been pressed. The value previously displayed will be
restored.

If 'Time' is selected:
Set the time using the '+' or '–' keys. Use the arrow keys to move from field to field.
Confirm with ENTER. Use the CANCEL key to return to the previous screen.
NOTE

The time must be entered in the following format: HH:MM in 24 hour clock
format; for example: 9:30 a.m. must be 09:30 and 9:30 p.m. must be
21:30. Press the CANCEL key to abort the operation or to cancel an
incorrect entry before ENTER has been pressed. The value previously
displayed will be restored.
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Move the cursor to the 'NEXT' field with the ARROW keys. Confirm with ENTER.

Bdr. Bus:>76800
Ctr No:>1
Bdr. M-Bus:>2400
>NEXT
Select
— 'Bdr. Bus' to set the baud rate for the C-Bus.
— ‘Ctr No” to set the controller number.
— ‘Bdr. M-Bus’ to set the baud rate for the Meter Bus.
Move the cursor with the arrow keys to the appropriate fields to set baud rates for
the C-Bus and M-Bus (if applicable) and the controller number. Use the '+' and '–'
keys to edit the fields. Confirm with ENTER.
IMPORTANT
If no controller number is set or if the number shown is not reconfirmed,
the controller will not go online on the C-Bus after start-up.
NOTE

Baud rate settings appear for all controller versions but are ignored if not
applicable for the hardware.

Move the cursor to the 'NEXT' field with the arrow keys. Confirm with ENTER.

>Select Applic.
>Requ. Download
>Gen. Def. Data
>NEXT
Select:
— 'Select Applic.' to choose the application manually.
— 'Requ. Download' to download an application via the XI584 PC MMI or the
C-Bus.
— 'Gen Def Data' to set up the test mode with default user addresses.
Confirm with ENTER.
If 'Select Applic.' has been selected this screen will show up:

Select Applic.
>AH01
↑
<application name> 1
<application name> ↓
Select the application using the ARROW keys. Confirm with ENTER.

Honeywell
XL 50 V 2.03.00
AH01
V 1.00
>NEXT

This line appears in
configurable applications only.

The initialization screen of the chosen application will show up. It displays
information about the versions of the controller and the application. Confirm with
ENTER.
If the Excel 50 controller is connected to a C-Bus, unless using the HE01
application module (bus number appended automatically), this screen will show up:
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Append Busnumber
to User Addr. ?
>YES
>NEXT
Move the cursor to the 'YES' field. Confirm with ENTER.
IMPORTANT
If more than one Excel 50 Controller with the same application program is
connected to the C-Bus, the user addresses must have the bus numbers
appended to them.
For HE01 applications, bus numbers are appended automatically except
for remote points which must have the remote controller number entered in
through the Data Points sequence (see Data Points section).
Move the cursor to the NEXT' field using the ARROW keys. Confirm with ENTER.

>CONFIG
C2>-1
C4>-1
C6>-1

C1>-1
C3>-1
C5>-1

This screen appears in
configurable applications only.

In this screen the codes of the configurable application can be changed. The
application codes can be generated with the 'LIZARD-Excel 50 Application
Selector'. This screen does not appear with standard and custom CARE
applications.
NOTE

Not all applications have 6 configuration code numbers. Applications with
8 configuration codes have two on a second screen as shown below.
First screen:

C1>-1
C3>-1
C5>-1

C2>-1
C4>-1
C6>-1
>NEXT

Second screen:

>CONFIG
C7>-1
NOTE

C8>-1

If the 'LIZARD-Excel 50 Application Selector' is not available, please
contact your local Honeywell branch for support.

Select the appropriate code and change its value using the '+' and '–' keys.
Move the cursor to the 'CONFIG' field. Confirm with ENTER.
If the codes entered in the screen are allowed, the default screen of normal
operation will show up:

<1. time program>
MON 13.06. 10:27
TO: 20:30 20°C
>TODAY
>NEXT
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If one or more codes entered are not allowed, the initialization screen will show up
again. Change the screens by selecting NEXT and confirming with ENTER until you
have reached the configuration screen again. Codes which are not allowed have
the value '-1' instead of the previously entered code. Change the codes until all
codes are correct.
You will now come to the default screen of normal operation:

<1. time program>
MON 13.06. 10:27
TO: 20:30 20°C
>TODAY
>NEXT
Refer to the chapter 'Plant key' for information about this screen.

Test Options
>Select Applic.
>Requ. Download
>Gen. Def. Data
>NEXT
If 'Gen. Def. Data' has been selected from the Select Application/Request
Download/Gen. Def. Data screen, default user addresses are generated following
the following pattern:
AI0101
AO0201
DI0301
DO0401
NOTE

— Analog input, board 1, input 1
— Analog output, board 2, output 1
— Digital input, board 3, input 1
— Digital output, board 4, output 1

The board numbers shown above are internal references and are not
relevant to the User. In Excel 50 Controllers the numbers are fixed for the
I/O type, i.e. analog inputs are always AI01, digital inputs are always DI03,
etc.

After generating the default addresses, a screen will display the most recent alarm,
if one exists

<date.>
<user addr.>
<value>
<alarm text>

<time>

Press CANCEL to return to the previous screen.

>Select Applic.
>Requ. Download
>Gen. Def. Data
>NEXT
Select NEXT and confirm with ENTER. The second screen of test options appears:
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>DISP DEF DATA
>ALARM HISTORY
Select
— 'DISP DEF DATA' to display I/O points for checking values and manually
setting outputs for testing.
— 'ALARM HISTORY' to display current alarms. This feature allows the system to
be checked out by a single person opening and closing inputs and then later
reading the alarm buffer to see if they were detected by the controller.
Confirm with ENTER.
If ‘DISP DEF DATA’ has been selected, the following screen will be displayed
showing all default user addresses and their current values.

><user addr.>
><user addr.>
><user addr.>
><user addr.>

<val>↑
<val>1
<val>
<val>↓

To manually set outputs, move the cursor to select the output point from the list box
using the arrow keys. Confirm with ENTER.
For analog points the following screen is displayed

<user addr.>
STATE/VALUE:
> 0.00%
Press ENTER to select the value. Change the value using the '+' or '–' keys.
Confirm with ENTER. For digital points the following screen is displayed

<user addr.>
STATE/VALUE:
>0
%
Press ENTER to select the value. Change the value/state using the '+' or '–' keys.
Confirm with ENTER.
Press CANCEL to return to the previous screen (list of user addresses).
If ‘ALARM HISTORY’ has been selected, the following screen will be displayed
showing all points in alarm as well as any system alarms (max. 100 entries):

><user addr.>
><user addr.>
><user addr.>
><user addr.>
NOTE

↑

1
↓

Alarms are generated for changes of state/value on inputs, which allows
shorting and opening the inputs at the switches and/or sensors and then
checking the alarm buffer to verify the wiring.

To view an alarm, move the cursor to select the default user address from the list
box using the arrow keys. Confirm with ENTER. The following screen will appear:
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<date.>
<user addr.>
<value>
<alarm text>

<time>

Press CANCEL to return to the previous screen.
IMPORTANT
Reset the controller after using the test options to clear the alarm buffer.

Adjustable Remote Trend Buffer (V2.03.x)
With firmware 2.03.00 or newer, memory that is not used by the application can be
used as additional remote trend buffer for XBS Central A. By maximizing the trend
buffer size, the number of times the controller must dial-up the central is minimized
as is the risk of trend samples being overwritten due to a full buffer.
By exploiting this feature, it is possible to use the EXCEL controller as a pure
trending device, when no application is downloaded.
The amount of additional memory available for the remote trend buffer is
determined by the value for “Application Memory Size” entered with the MMI during
the start-up sequence of the controller. This number is subtracted from the total
application memory, and the resulting number, in Kbytes, is the additional remote
trend buffer size. The following figure illustrates the adjustable remote trend buffer.
TOTAL APPLICATION MEMORY

REMOTE TREND BUFFER

UNUSED APPLICATION MEMORY
e.g. 58 KBYTES
58 KBYTES
= 1263 ADDITIONAL TREND SAMPLES
128
KBYTES

APPLICATION
e.g. 70 KBYTES
+ 104 TREND SAMPLES (DEFAULT)
= 1367 T0TAL TREND SAMPLES

Adjustable remote trend buffer example.
The maximum number of trend samples will be displayed on the MMI once a value
for application memory size is entered.
The adjustment range for the application memory size is the following:
Application memory size
Default:

Trend samples in
remote trend buffer

128 Kbyte

104 per central

Maximum: 128 Kbyte

104 per central

Minimum:

104 per central
PLUS “N” for central A

10 Kbyte

>N< is approximately:
(128 Kbytes – application size in Kbytes) x 1024 bytes / 47 bytes
Hence, the maximum of >n< is 2570 trend samples.
This means, for a minimum application size of 10 Kbytes there will be 2674 (2570 +
104) trend samples for central A and 104 trend samples for central B and C each.
If an application being downloaded exceeds the application memory size, a warning
message will be displayed on the MMI, and the download will not be executed.
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OPERATOR ACCESS LEVELS
Password protection ensures that only authorized personnel have access to system
data to ensure reliable and trouble-free operation using the preset values.
The Operator access level 1 is not password-protected. This level enables only to
read data such as setpoints, switching time points and operating hours.
The Operator access levels 2 and 3 are password-protected. Authorized personnel
can edit the preset values at those levels. Operator access levels 2 and 3 have
different passwords.
Operator access level 1 - read only (default values)
- no password
Operator access level 2 - read and limited changes
- level-2 password
Operator access level 3 - read and make unlimited changes - level-3 password

TIME PROGRAM DESCRIPTION
Direct access to the time program menu can be obtained via the fast access key.
Pressing the time program fast access key displays the password entry screen.
Refer to the section entitled 'Password' for help with password entry.
Time programs are used to assign setpoint values and control status conditions to
specific user addresses at specific times.
The time program can be adapted to suit the application. A time program comprises
the system time (which includes the actual date, time and daylight saving time) and
various time-related programs, the daily time programs, the weekly time program
(created from daily time programs) and the annual time program. Time program
switching points can be edited via operator access levels 2 and 3.
System Time

Daily Time Program

The system time includes the actual date and time and the start and end date of the
daylight saving time. It regulates all analog and digital control strategies
implemented in the application software program.
Switching point times with the desired value/status for the appropriate user
addresses are entered into the daily time program.
Example: The daily time program 'Workday' has several switching point times:
Workday

Weekly Time Program

06:00

AH1_occ

08:00

AH1_tsp

09:00

AH1_psp

Daily time programs are assigned to each day of the week in the weekly time
program. The weekly time program is automatically repeated every week and
creates the normal annual time program.
Example 1: Monday to Friday inclusive require the same daily time program.
Saturday and Sunday require a different daily time program:
Monday

Workday

Tuesday

Workday

Wednesday

Workday

Thursday

Workday

Friday

Workday

Saturday

Weekend

Sunday

Weekend
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Example 2: Thursday requires a different daily program and is assigned to the daily
time program DP_2:
Monday

Workday

Tuesday

Workday

Wednesday

Workday

Thursday

DP_2

Friday

Workday

Saturday

Weekend

Sunday

Weekend

NOTE

Annual Time Program

If the 'COPY' function is used to create a new daily time program the next
free daily time program will be assigned. This means that the default daily
time program can be overridden by a new daily time program. Daily time
programs cannot be deleted from the PC central.

The annual time program can be changed for a specific period. A daily time
program out of the daily time program list can be assigned to a period which is
specified by the beginning and end date.
Example: The annual program consists of the normal weekly program. Only during
the holiday period every day is assigned to the 'Weekend' daily time program.

Optimization

From 01.01.1997 to 15.07.1997

normal weekly program

From 15.07.1997 to 30.08.1997

'Weekend' daily time program

From 30.08.1997 to 31.12.1997

normal weekly program

The optimization function causes optimization of a switching point. It has two states,
ON and OFF.
The optimization compensates the time an environment needs to reach a wanted
condition (temperature, humidity, etc.) by bringing forward the switching point of the
corresponding device.
NOTE

The optimization can only be set to ON if the user address of the device is
suitable for optimization.

Example: If the optimization is ON, a heating plant is switched on early in order to
have your home at the required setpoint level by a particular time.
Programmed switching point:
6:00 to 20 °C
Real switching point:
4:52 to heating ON
The difference between the programmed and real switching point is the estimated
time a room needs to warm up under the current conditions.
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DATA POINTS / PARAMETERS DESCRIPTION
Direct access to the 'Data points / parameters' menu can be obtained via the fast
access key. Pressing the 'Data points / parameters' fast access key displays the
password entry screen. Refer to the section entitled 'Password procedure' for help
with password entry. Access to edit value/status depends on the operator access
level.
User Address

The Excel 50 controller has physical, remote and pseudo data points. The user
address is an attribute of the data point. Each user address represents one data
point.
Information can be obtained about the following data point types:

Physical Data Points

analog inputs
analog outputs
digital inputs
digital outputs
totalizers
Physical data points are inputs and outputs directly connected to a hardware device
such as a sensor or an actuator. The Excel 50 controller has the facility for 22
physical data points.

Pseudo Data Points

pseudo analog
pseudo digital
pseudo totalizers
Pseudo data points are generated in software to achieve the application program.
They are not connected to any hardware device. The Excel 50 can have a
maximum of 128 pseudo points of each type.

Remote Points (HE01 only)

remote analog
remote digital
Remote points (also known as global points) are data points which are used by
more than one controller on the same bus. The controller number for the device that
is the source of remote point must be entered via MMI in the controller receiving the
point.
The data points / parameters fast access key also provides access to the following
data
parameters
system data
DDC program cycle time
M-Bus configuration
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Data Point Attributes
The following data points are available on the operator's terminal.
Different attributes are assigned to each data point type as follows:

EN2B-137

Analog Inputs

Digital Outputs

Pseudo Digital Points

User address
Descriptor
Technical address
Operating mode
Value
Manual value
Engineering unit
Suppress alarm
Min limit 2
Min limit 1
Max limit 1
Max limit 2
Sensor offset
Trend Log
Trend Hysteresis
Trend Cycle

User address
Descriptor
Technical address
Operating mode
Value
Manual value
Alarm reporting
Hours run
Suppress alarm
Trend Log

User address
Descriptor
Operating mode
Value
Manual value
Suppress alarm
Hours run
Trend Log

Analog Outputs

Totalizer Inputs

Pseudo Totalizer Inputs

User address
Descriptor
Technical address
Operating mode
Value
Manual value
Engineering unit
Suppress alarm
Time to open/time to close
Trend Log
Trend Hysteresis
Trend Cycle

User address
Descriptor
Technical address
Operating mode
Value
Manual value
Suppress alarm
Trend Log

User address
Descriptor
Operating mode
Value
Manual value
Suppress alarm
Trend Log

Digital Inputs

Pseudo Analog Points

Remote Data Points (HE01 only)

User address
Descriptor
Technical address
Operating mode
Value
Manual value
Alarm reporting
Hours run
Suppress alarm
Trend Log

User address
Descriptor
Operating mode
Value
Manual value
Engineering unit
Suppress alarm
Min limit 2
Min limit 1
Max limit 1
Max limit 2
Trend Log
Trend Hysteresis
Trend Cycle

User address
Technical address
Value
Engineering unit
Trend Log
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Operating Mode
This attribute enables the user to switch between manual and automatic operation.
Automatic Operation

Manual Operation

Under normal automatic operation the controller processes the values at the inputs,
e.g. from temperature sensors. For outputs, under normal operation, the status
shown by the user / time program is adopted, e.g. 'Heating circuit pump off'. The
feedback loop of the control system is closed.
During manual operation the controller uses the manual values, e. g. 'Flow
temperature setpoint = 60 °C'. Outputs adopt the preselected condition, e. g.
'Heating circuit pump on'. The feedback loop of the control system is interrupted.
For automatic operation the 'Operating mode' attribute contains the inputs 'Auto'
and 'Manual'. Each change from automatic to manual and back again generates
a critical alarm.

Value

Manual Value

When the controller is working in automatic mode (the 'Operating mode' attribute is
set to 'Auto') the value or the current status being processed by the application
program can be found in the 'Value' attribute. The 'Value' attribute for an analog
input is, for example, the current room temperature of 21 °C / 70 °F. The 'Value'
attribute for a pump switched by the digital output is , for example, the current status
'ON'.
When the controller is working in manual mode (the 'Operating mode 'attribute is
set to 'Manual') the preset manual values can be found in the 'Manual value'
attribute.
Example:
In the example shown the 'Operating mode' attribute is set to 'Manual', i.e.
the data specified manually is written into the 'Manual value' attribute,
processed in the controller and passed on to an output. The user can, of
course, recall the measured value coming from the 'Value' attribute, but
this has no effect on the application program.

Hours Run
An hours run log can be carried out for digital data points (physical and pseudo),
e.g. Iogging the hours run by a heating circuit pump. The accumulated hours run
are displayed in the 'Hours run' attribute. Hours run values have a resolution of
1 minute.
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Technical Address
The Excel 50 controller has 22 physical inputs / outputs. Each physical data point
has a fixed technical address which contains information about the controller
number, the board number and the input / output number on the board.

User Address
The 14-character user address for each data point (physical and pseudo) can be
displayed on the operator's terminal. Access to edit all physical and pseudo data
points depends on the operator's access level.
When more than one controller with the same application program exists on the
C-bus the controller number must be attached to the user address and the
controller name to make the user addresses unique.
The user addresses can be changed during the start-up or cold start via the
operator's terminal by confirming with 'YES' in the 'Append bus number to user
address?' screen. Refer to the diagram below.
If the 'YES' field is selected the controller number will be automatically attached to
the controller name (characters 14 and 15) and to the user address (characters 17
and 18).
Example

The user address is 'RoomTemp'.
Controller number: 02
If the user address is changed the text string will be displayed as follows:

RoomTemp------02
The controller number is only displayed on the PC central and not on the operator's
terminal.

Suppress Alarm
The attribute 'Suppress alarm' gives the user the possibility to choose which Point
Alarm will be generated and which one not.
In case 'Suppress alarm' is set to YES, there will be no alarm generated, even if the
alarm condition of this data point occurs.
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ALARM DESCRIPTION
Direct access to the alarm handling menu can be obtained via the 'Alarms' fast
access key. The alarm handling facility within the controller stores alarm data for
immediate display at the operator's terminal.
Pressing the 'Alarms' fast access key displays the main alarm menu screen to
enable selection of the following:
•=
•=
•=
•=
Typical Alarm Information

alarm buffer
points in alarm
critical alarms
noncritical alarms.

- Date and time the alarm occurred
- User address of the point in alarm
- Value/status of the point in alarm
- Alarm text, e.g. MIN1 alarm.

Alarm Buffer

The last 99 alarms are stored in the alarm buffer. They contain the user address,
alarm text, date and time. When the alarm memory capacity is exceeded the first
alarm is overwritten. Alarms are organized on a first in, first out basis. The contents
of the alarm buffer can be displayed on the operator's terminal.

Point in Alarm

All data points currently in an alarm condition, i.e. the alarm limit for an analog point
or the alarm status for a digital point has been reached, can be displayed on the
operator's terminal. When selecting this option the user address and associated
alarm text will be displayed.

Critical and Noncritical Alarms

Alarm Attributes

The following attributes can generate alarms and will write them into the alarm
buffer as well as sending them to the PC central via the C-Bus.
operating mode
minimum limit
maximum limit

always a critical alarm
optional critical or alarm status
optional critical or totalizer alarm status

While the 'Operating mode' attribute always results in a critical alarm, the 'Alarm
type' attribute offers a choice of critical or noncritical alarm classification for the
'Min/Max limits', 'Totalizer' and 'Alarm status' attributes.
System Alarms Description

Operating malfunctions that arise within a controller, e.g. power failure or during
communication with another Excel 5000 device, are displayed on the operator's
terminal.
System alarms are always critical alarms.

Min Limit / Max Limit Monitoring

Two maximum limits ('Max Lim1' and 'Max Lim2') and two minimum limits
('Min Lim1' and 'Min Lim2') can be independently set for physical and pseudo
analog inputs.
The limit values can be changed using the operator sequence. Each time a limit
value is reached, irrespective of direction, an alarm is generated.
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The following four limit values are available:
minimum limit 2
minimum limit 1
maximum limit 1
maximum limit 2
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